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Author Questionnaire 
1. We have marked your project as author-provided footage, meaning you film the video yourself and provide JoVE with the footage to edit. JoVE will not send the videographer. Please confirm that this is correct. 
☐ Correct 
☐ Incorrect 

 2. Microscopy: Does your protocol require the use of a dissecting or stereomicroscope for performing a complex dissection, microinjection technique, or something similar?  Enter Yes or No.  
If a dissection or stereo microscope is required for your protocol, please list all shots from the script that will be visualized using the microscope (shots are indicated with the 3-digit numbers, like 2.1.1, 2.1.2, etc.).
Click here to list microscope shots, using the shot numbers from the protocol section of the video script.

3. Software: Does the part of your protocol being filmed include step-by-step descriptions of software usage?  Enter Yes or No.
If Yes, we will need you to record using screen recording software.
We recommend using the screen capture program OBS. JoVE’s tutorial for using OBS Studio is provided at this link: https://review.jove.com/v/5848/screen-capture-instructions-for-authors?status=a7854k

As these files are necessary for finalizing your script, please upload all screen captured video files to your project page as soon as possible.

[bookmark: Text5]4. Proposed filming date: To help JoVE process and publish your video in a timely manner, please indicate the proposed date that your group will film here: MM/DD/YYYY

DO NOT use this draft script for filming. Please wait until your script is finalized to begin the filming process. 

When you are ready to submit your video files, please contact our Content Manager, Utkarsh Khare. 

To ensure that your script can be filmed in one day, the protocol sections are cumulatively restricted to 55 shots (shots are the 3-digit numbers like 2.1.1, 2.1.2…etc)

Current Protocol Length

Number of Steps:  19
Number of Shots:  36 (21 SC) 

Introduction 

Answers to these questions will become interview statements that you will deliver on camera.
· Answer the 1st REQUIRED question and at least 2 other questions (1.2 – 1.10) below. Up to 5 interview statements will be included in the video.
· Enter the full name of the author who will deliver the statement.
· If possible, each author should deliver no more than two statements.
· Answer in full sentences, in a style suitable for being spoken aloud.
· Limit the length of each statement to 30 words or fewer.
· Answers will be edited for length, clarity, and consistency with journal style guidelines.

REQUIRED: What is the scope of your research? What questions are you trying to answer? 
1.1. Enter author name.: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What are the most recent developments in your field of research?
1.2. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What technologies are currently used to advance research in your field?
1.3. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What are the current experimental challenges?
1.4. Enter author name: Click here to answer question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What significant findings have you established in your field?
1.5. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What research gap are you addressing with your protocol?
1.6. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

What advantage does your protocol offer compared to other techniques?
1.7. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
How will your findings advance research in your field?
1.8. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What new scientific questions have your results paved the way for?
1.9. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.
What research questions will your laboratory focus on in the future?
1.10. Enter author name: Click here if you choose this question. Please write in a style that you will be comfortable memorizing and speaking aloud. Limit length to 30 or fewer words.

Ethics Title Card
This research has been approved by the local ethical committee at the Federal University of Rio Grande do Norte 


Protocol  
[bookmark: _Hlk188263998]Please review this section to make sure that it accurately describes your protocol. Use Track Changes when making edits or revisions.
· The two-digit steps (e.g., 2.1., 2.2.) are the narration.  JoVE is responsible for the narration of the protocol and results.
· Red italics are pronunciation guides indicating how the word will be spoken. 
· Filming should take no more than 10 minutes per step. If a step takes more than 10 minutes, prepare the product for that step in advance.
· The three-digit shots (e.g., 2.1.1., 2.2.2.) are the actions that you/your videographer will capture. 

2. Administration of PTZ (Pentylenetetrazol) to the Animal 
Demonstrator: Click here to enter name of demonstrator(s)


2.1. To begin, use a scale to measure the body weight of the animal [1].
2.1.1. WIDE: Talent weighing the animal using a digital scale on a benchtop.

2.2. Calculate the volume of pentylenetetrazol solution needed for each animal based on their body weight [1].
2.2.1. Talent entering the animal’s weight into a calculator or spreadsheet on computer.

2.3. Record the animal’s behavior inside the arena for at least 1 hour prior to the pentylenetetrazol injection [1]. This habituation period reduces novelty-induced ambulation and anxiety and allows extraction of baseline activity [2].
2.3.1. Talent placing the animal in the arena.
2.3.2. Shot of the animal activity in the recording arena.

2.4. Prepare the pentylenetetrazol injection [1]. For subcutaneous administration, use one hand to secure the animal [2] and gently pinch the skin between its shoulder blades [3].
2.4.1. Talent preparing the syringe for pentylenetetrazol injection.
2.4.2. Talent holding the animal with one hand.
2.4.3. Talent gently pinching the skin at the scruff to expose the subcutaneous space.

2.5. Using a 1 milliliter syringe attached to a 26 and a half-gauge needle, insert the needle into the subcutaneous space in parallel with the body orientation [1] and inject the solution slowly [2]. Once the injection is complete, gently remove the needle while holding the skin at the exit point to prevent leakage due to internal cavity pressure [3].
2.5.1. Close-up of needle being inserted subcutaneously along the spine.
2.5.2. Talent pushing the syringe plunger.
2.5.3. Talent removing the needle while pressing the injection site gently with fingers.

2.6. Observe and make a note of any solution leakage from the injection site [1-TXT]. If leakage is present, consider administering an additional 50 microliters of the same pentylenetetrazol solution [2].
2.6.1. Talent inspecting the injection site for any leakage. TXT: Administer 50 μL of the same solution if leakage is observed

2.7. Now, place the animal back into the arena [1] and record continuously for 1 hour [2].
2.7.1. Talent gently returning the animal to the arena.
2.7.2. Talent pressing the record button on the camera.

2.8. One hour or more after pentylenetetrazol injection, stop the recording and copy the video file for post-processing [1]. Use this for video tracking and behavioral coding [2].
2.8.1. Talent stopping the recording.
2.8.2. SCREEN: Show the file being saved and copied into a designated folder on the computer.
[bookmark: _Hlk162020732][bookmark: _Hlk162020892]Authors: Please create screen capture videos of the shots labeled as SCREEN, create a screenshot summary, and upload the files to your project page as soon as possible (download the guidelines from the link given in the email): https://review.jove.com/account/file-uploader?src=20774208 


3. Software Configuration for Post-Processing
Demonstrator: Click here to enter name of demonstrator(s)

3.1. Open the Solomon Coder software [1].
3.1.1. SCREEN: Show desktop screen where Solomon Coder is selected from the Start menu.
3.2. If a configuration file is available, select File and click Load Configuration to load predefined settings [1].
3.2.1. SCREEN: Show Solomon Coder interface with mouse clicking on File > Load Configuration and configuration settings being loaded.

3.3. To open a video, select File and click Open Video [1].
3.3.1. SCREEN: Show file explorer opening and a video file being selected from a directory and opened in Solomon Coder.

3.4. Press Play to begin video playback [1].
3.4.1. SCREEN: Show the video interface with the Play button being clicked and the video starting to run.

3.5. Click the left mouse button or press the assigned keyboard key to mark observed behaviors during playback [1].
3.5.1. SCREEN: Show the user marking behaviors.

3.6. To save the data, go to Analyze and select Save Output As to create a comma-separated values file [1]. For the coding sheet, go to File and choose Save Coding Sheet [2].
3.6.1. SCREEN: Show Analyze > Save Output As being selected and a .csv file being saved.
3.6.2. SCREEN: Show File > Save Coding Sheet being selected and an .arch file being saved.




4. Coding Behaviors Post-PTZ Injection
Demonstrator: Click here to enter name of demonstrator(s)

4.1. Tag the pentylenetetrazol administration time at the moment the mouse reappears in the video frame after being returned to the observational arena [1]. Use this moment as time zero to serve as the temporal reference point for all subsequent behaviors and latency calculations [2].
4.1.1. SCREEN: Show video playback with the moment the mouse first reappears in the frame being tagged on the timeline.
4.1.2. SCREEN: Show annotation being added on the timeline labeled “Time Zero” as the reference point.
4.2. Observe for spasms and myoclonia a few minutes after pentylenetetrazol injection [1]. Identify spasms as fast, transient contractions of axial muscles, including bilateral ear flexion, back muscle contraction, tail raising, and rarely, a startle jump [2]. Code these spasms as discrete, instantaneous events, associating them with a single video frame [3].
4.2.1. SCREEN: Show video playback where spasms begin to appear after injection.
4.2.2. SCREEN: Highlight a frame where a tail raise or ear twitch occurs.
4.2.3. SCREEN: Annotate the selected frame with the label “Spasm – single-frame event.”

4.3. To code myoclonias, identify events longer than 200 milliseconds, marked by a strong, abrupt myoclonic jerk of the head, neck, and paws [1]. Classify subtypes based on associated tremors or directional posture loss including forward, leftward, or rightward [2]. Code the event across multiple frames, as the duration typically ranges from 1 to 2 seconds [3].
4.3.1. SCREEN: Show a segment of video playback featuring a myoclonic jerk with time overlay visible.
4.3.2. SCREEN: Label and subclassify the myoclonia based on observed characteristics.
4.3.3. SCREEN: Go to a different frame, mark the beginning and end of a myoclonia event across the timeline.

4.4. For limbic seizures, identify behaviors aligned with the Racine scale, starting with behavioral arrest or staring [1]. Follow with automatisms, orofacial movements, forelimb or head myoclonus, and escalation to rearing, jumping, or tonic seizures [2]. Use the modified Racine scale to assign subcategories to events lasting longer than 10 to 15 seconds [3].
4.4.1. SCREEN: Playback of a seizure onset showing the animal freezing or staring.
4.4.2. SCREEN: show progression into orofacial and rearing behaviors.
4.4.3. SCREEN: Show seizure duration measured on the timeline.

4.5. Finally, mark the end of the recording session on a single video frame exactly 1 hour after pentylenetetrazol injection [1]. If the animal dies following a tonic seizure, identify the time of death with this final frame mark [2].
4.5.1. SCREEN: Tag the 1-hour mark on the timeline as the session endpoint.
4.5.2. SCREEN: If applicable, label the final frame with “Death Timepoint” based on tonic seizure outcome. Authors: Do not show the video of animal dying



Results
Please review this section to make sure that it accurately reflects your findings.
· This section will not be recorded by the videographer. It only includes the figures/tables from your manuscript (called LAB MEDIA). 
· Use Track Changes when making edits or revisions. Ensure the voiceover length is below 200 words. Current word count: 155.
· Please note that the video cannot include voiceover without an accompanying visual.

5. Results 

5.1. The figure details parameters that can be extracted from this coding system, including latency to each ictal behavior, number of events, event duration, inter-event interval, and severity of limbic seizures [1].
5.1.1. LAB MEDIA: Figure 4

5.2. Spasms typically involved trunk stiffening in majority of events [1], while only 6% of spasms exclusively activated the tail [2].
5.2.1. LAB MEDIA: Figure 5B. Video editor: Highlight the large dark red section in each bar representing “tr 55%”
5.2.2. LAB MEDIA: Figure 5B. Video editor: Highlight the small light section in each bar representing “tl 6%”

5.3. Myoclonias presented predominantly as tremors in 64% of cases [1]. Forward [2], rightward [3], and leftward motions were also noted [4].
5.3.1. LAB MEDIA: Figure 5C. Video editor: Highlight the dark purple segments in all the bars labelled “tremor”
5.3.2. LAB MEDIA: Figure 5C. Video editor: Highlight the light blue segments labelled “forward”
5.3.3. LAB MEDIA: Figure 5C. Video editor: Highlight the white segments labelled “rightward”
5.3.4. LAB MEDIA: Figure 5C. Video editor: Highlight the light purple segments labelled “leftward”

5.4. The latency to onset was significantly different among spasms, myoclonias, and limbic seizures [1], with spasms occurring earliest [2].
5.4.1. LAB MEDIA: Figure 5D
5.4.2. LAB MEDIA: Figure 5D. Video editor: Highlight the first box (spasms) 

5.5. The total number of spasms was significantly higher [1] than that of myoclonias or limbic seizures [2].
5.5.1. LAB MEDIA: Figure 5E. Video editor: Highlight the first bar (spasms)
5.5.2. LAB MEDIA: Figure 5E. Video editor: Highlight the bars for myoclonias and limbic seizures

5.6. The median inter-event interval did not differ significantly between spasms and myoclonias [1], but the limbic seizures lasted significantly longer than myoclonias [2].
5.6.1. LAB MEDIA: Figure 5F. 
5.6.2. LAB MEDIA: Figure 5G. Video editor: Highlight the second boxplot (limbic seizures) 

5.7. In the daily PTZ injection protocol, spasm latency and events significantly decreased by day 8 [1], whereas the inter-spasm interval increased [2].	Comment by Poornima  G: Authors, please check this and confirm if this is correct. In manuscript it is written that in latency and events increase, but intervals decreased. But the plot shows otherwise.
5.7.1. LAB MEDIA: Figure 6C and D. Video editor: Emphasize the boxplot for day “8” (extreme right)
5.7.2. LAB MEDIA: Figure 6E. Video editor: Emphasize the boxplot for day “8” (extreme right)
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